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1.0  INTRODUCTION & LEARNING OUTCOMES

This handout:
· Is at beginner's level and covers only the key features of EndNote basic. It is assumed that you have never used EndNote basic or are unfamiliar with it.

· Does not teach you how to reference. You are expected to have a basic knowledge of referencing and your School’s referencing style.

· Does not teach you how to search in databases. You are expected to be familiar with basic database searching, as some basic database searching is involved.

· The Library’s subject guide EndNote Online (http://rmit.libguides.com/EndNote_Online) is useful as a self-paced instructional tool.

· Does not cover advanced areas. The following resources address advanced questions:


· [bookmark: _Hlk8896253][bookmark: _Hlk8896532]EndNote Online quick reference guide 
http://clarivate.libguides.com/ld.php?content_id=34785308

· EndNote.com subject guide
http://clarivate.libguides.com/endnote_training/endnote_online
 
· EndNote -  YouTube Channel
https://www.youtube.com/playlist?list=PLAEGcPDviwLY_MePrJAum34xt8Nz9-Kub
 
· EndNote.com Community (User Forum)
http://community.thomsonreuters.com/t5/EndNote/ct-p/endnote
 
· EndNote.com Support – Common Questions
      https://support.clarivate.com/Endnote/s/?language=en_US



[bookmark: _GoBack]What is EndNote basic?

· EndNote basic is a free, simple web-based reference management tool that enables you to collect, manage, store and share references, and make them available online. It is the online version of the EndNote Desktop software program. EndNote basic also allows you to create and export a reference list. There are many different referencing management programs available, however, EndNote is supported at RMIT.

· You can use EndNote basic together with EndNote Desktop, or as a stand-alone tool.

· To use EndNote basic, you need to create an EndNote Online account. There are three ways of creating and using an EndNote Online account. This handout will demonstrate the use of EndNote basic as a stand-alone tool.

· EndNote basic has similar, but more restricted, functionality to the Desktop version of EndNote. Endnote basic would be ideal for undergraduates, Vocational Education students and anyone else who may use only a few references in their assignments.

· EndNote has changed the name from EndNote Web to EndNote Online. However, many databases/links may still refer to it as EndNote Online or EndNote Web.

· [bookmark: _Hlk8893227]Ensure you check Easy Cite, RMIT’s referencing tool, for correct guidelines and examples on how to reference in your chosen style. Go to: https://www.lib.rmit.edu.au/easy-cite/.

Learning Outcomes:

· Create an EndNote basic library.

· Install Plugins.

· Populate or add references to an EndNote basic library - manually & directly from library databases, Google Scholar and LibrarySearch.

· Create and use groups to better organise your references.

· Use EndNote basic with Microsoft Word in your chosen referencing style.

· Know how to get further help for EndNote basic.

2.0  CREATE AN ENDNOTE BASIC ACCOUNT

Additional information on accessing the EndNote basic and creating a library can be found at: http://rmit.libguides.com/EndNote_Online

For the purposes of this session an EndNote basic account will be created via 
www.myendnoteweb.com

1. Go to www.myendnoteweb.com or Google ‘endnote online’.
2. Click on the Sign up account link.
3. Follow the prompts to create your account with your RMIT student/staff email address.
4. Activate your EndNote basic account through an email sent to your email address.

	Tip: Passwords must be 8 characters with at least one symbol, letter and number.

If you forget your password, you will need to use the same e-mail address you created your account with OR currently associated with your account in order to reset a new password.



	Tip: Accessing your EndNote basic account after graduating from or leaving RMIT
Once you have graduated from or left RMIT, you will no longer have access to your RMIT e-mail address that you have used to create your EndNote basic account with. If you need continued access to EndNote basic after graduation or leaving, you can associate your EndNote basic account with a different e-mail address (e.g. personal) just before you graduate or leave. Simply change your e-mail address via Options > E-mail Address in the top toolbar.




Getting Started Guide: The first time you sign in to your EndNote account, you will see the Getting Started Guide, which offers links to help collect, organise, and format references.


3.0 INSTALL PLUGINS

To enable the transfer of records between EndNote basic and Microsoft Word, plugins must be installed on personal computers. You do not need to install this plugin if you already have EndNote Desktop installed. EndNote Desktop is already installed on RMIT student computers.

For a personal device, go to the Downloads tab in EndNote basic. The Cite While You Write (CWYW) plugin allows you to insert references, format citations and bibliographies automatically while you write your assessments in Microsoft Word.

[image: https://lh5.googleusercontent.com/IHhxqC0WHPhfScREpeyoOdse-CTxCKcCQIWRQLDmY9ODt84VxPnkqM0TaCgQXCnpy-ebOjCHXo9wUFbYoEcR-UuMv6QY4bJFjlqFkb-niqY61MF4VCIPYqx1l3mo0vb6kjTNIFgP]


4.0 ADDING REFERENCES TO ENDNOTE BASIC LIBRARY

There are a number of ways to add references to an EndNote basic library. Before we do this, we need to set up the import settings to allow the importing of references from different places, e.g. library databases, Google Scholar. We only need to do this once. It is important to add the following two formats for the following activities. Follow the steps below for any other required formats for databases in the future. 


To set up the import settings:

1. Go to Collect.

2. Select Import References.

3. Then Select Favourites.

4. Add the following to My Favourites by clicking on Copy to Favourites. We will use the following databases as examples. You can also select other examples at any time by returning to this screen -- please do this before you import references.

· Science Direct
· EndNote Import (for Google Scholar)

[image: https://lh5.googleusercontent.com/5udCLLn-jzmlGSKHNJNO39olnbYygUk53-lQQHffeO7fTZm3VgQbXWyC5ad1i2Fn66LtGlXqjrSOO8s9BP8bp8G6ZMwhFJ15-PDclI5ccCamgO9XYd0exfsvmQ9WgbXRKZ7VEWdK]


4.1 EXPORT RECORDS FROM LIBRARYSEARCH

LibrarySearch allows you to export references directly into your EndNote basic library. You can do this individually (from a Library record) or from multiple references from My e-Shelf.

Adding a single reference from LibrarySearch:

1. Login to LibrarySearch.
2. Do a search for a topic.
3. Click on the title of an item.
4. Then select EndNote Online from the menu Save record as.

[image: ]

Adding multiple references from LibrarySearch:

1. Go back to the results list for the search.
2. Collect titles by selecting the pin [image: https://lh6.googleusercontent.com/ovi21Gt8A5LNOHeuah310xY0CIZ8u00fych8F_OyTovCZtPC0a__MUcS_C5zw_tIfbFXzITnZL-1zGoMYQ-FNF1NvoHtBeBf5-udzJI4cpC7JaVirg_yU197dp0fVmes0f56tmq4]to the right of each record. These will automatically be added to My Favourites.

3. Click on Go to My Favourites [image: Capture.PNG] and select the titles you want to export, then select the ellipsis (above the records) option, and then select EndNote Online.

[image: https://lh3.googleusercontent.com/bVaDEsgArABD0HbjSTsTilt1IUOu-AvnvrJ3ilJRETIj9tJPDKnwY6E-cldbA_Ohx2fQ2JkC07B2v8ldKt0GpfyRBZTGkBL9hOR225hN2BVmTV3WP80V3Bfn9cipzpDHFnww3kh-]

4. Your references have now been exported into your EndNote basic library.

	Tip: You can view or check the latest references by selecting the Sort by function > 
Added to Library-newest to oldest. 




	Tip: Always check each exported record to make sure that no information is incorrect or missing.




4.2 EXPORT RECORDS FROM A DATABASE

Export from a database is possible with some of the libraries' subscription databases. Web of Science, EBSCO and CINAHL are some of the databases where direct export option is available.

To use Direct Export:
1. Navigate from Library homepage to Databases A-Z > Popular Databases > EBSCOhostWeb

2. Do a search on your topic.

3. Add a few records by selecting the folder icon to the right of each record.

4. You can view your folder from the top menu bar.
[image: https://lh6.googleusercontent.com/MRmA-NMdjVrv_FVwoQqHxckkT7WZ1VulWj0RbLiMfV4t0gtsMKmzsDPeSJjYOuYCNbN6jB4or-I_SZbg2mqtNm4f9nkyBnHzdov_ax-b3uTQ9uXCUOst34w2vSakXzMpsplDdnt1]
0. Select the items and then choose the export option to the right.

1. Select Direct Export to EndNote Web and then select Save.
[image: https://lh6.googleusercontent.com/8BXyy4z3R8oWYiszJOAJ6TSpNyFE35QEamEKjgbhCUntAqzyzJMifiZiesTJ3WGvHBX9i0kCjfzpBHLI7li1oO03l0HYjRkUkiaMp79kDqbd22i5esKfAhPvKi00kwPYBwXhyoEg]

       7.   Exported citations will be saved to the Unfiled folder and can be viewed from My  References.


	Tip: You can view or check the latest references by selecting the Sort by function > Added to Library-newest to oldest. 



	Tip: Always check each exported record to make sure that no information is incorrect or missing.





4.3 EXPORT RECORDS FROM GOOGLE SCHOLAR

Google Scholar can be used to search academic material on the Internet. References from Google Scholar searches can be exported into an EndNote basic library.

To export records from Google Scholar:
 
1.   Navigate from the library homepage to Google Scholar. Log in with your student / staff number and password when prompted.

2.   At the top right corner, click on [image: https://lh4.googleusercontent.com/1Tu3GTzHFeLngLvZDxjUyMjIzLAP44_-ucNRkcDBRPErc5v3VIdL2uYS5DjGd-qGRJqRGJPAKJn7qRO_7BSWHmIoy659YmdapERqW5mjk4xQLIVIAN20RHwq6pAoIgFFHdPpiUcB]   and log in with the same RMIT login as above. You're now signed in to your Google Scholar account -- you can Sign Out when finished.

Note: If you have entered your RMIT e-mail address, clicked on Next and nothing happens, or if you receive the following message at this step -- 'Something went wrong, Sorry, something went wrong there' -- go directly to Google Scholar (https://scholar.google.com.au/) and log in via the above Sign in button again using the same e-mail address.
3.  Search on a topic in Google Scholar.
4.   Click on the white star [image: https://lh4.googleusercontent.com/10_09vF1RNi2s16n-KV-EXUgsBmZx9pe5kjuZxUNvlxKQNKtuZf5qiAZ58bCsgQiwlpkWjc3Wbq3BmzQDwA52PQBbG3qkxYgbMMN3VE5nLCSBNEHW4rylQu-6B4LTlL7tVogIAXU]   for each reference you want to export into your EndNote basic library. This will save the reference to My Library.
5.   When a reference has been saved to My Library, the white star changes colour to blue [image: https://lh4.googleusercontent.com/7ZXmi9qMewRFxvziVYnxWfVtm6fvKkjAf9j1QQ47K5A87_OplhPUrm0SYWVNi8SN8IOWueEXVcnVZysH0ND5jJgEUTwjhYzSex0a0XSc5g87Aml6TEt8V4NXeiIk-6dDvenLs7eo]. Clicking on the blue star removes the reference from My Library.

6.   Click on My Library on top right corner.

[image: https://lh4.googleusercontent.com/gAeob4DS01wl5Q1oFfC7dBBS6BuWDoD950hSv-EjhKcEgisaeoJW9Dd49gcNxH7pwXijYsVV54xCawxk2GPBTmq8xGbPqnOmtQna0aL3gwZdiysasvXs4RsWrBskcfMx2OOz_eoE]
 
Within here, you'll see a list of all the references you've saved in Step 5. Tick the references you want to export into EndNote basic.

[image: https://lh5.googleusercontent.com/hT48ODLHkiXBIpT_Jkxa3fe46MdIFpVoNNecbV70awhJFxBbbcMYL9phJeK7frjmy6jXobJQGGkyS8aLx6k6SgqW7EPenOUmrvki2RvmCikseK5Ay6MBmNnXaOTx0cuaYEJKqURx]
 


7.   Press the Export button and select EndNote. If you're using Chrome as a browser, it'll ask you to save the 'citations.enw' file, which you will then open. If you're using Firefox or Internet Explorer, it'll give you the option to either save or open the file.

[image: dd.png]

8. Save the references to your desktop as an enw file.

9. In your EndNote basic account, select the Collect tab and then click on Import  References.

10. At Import References, select the Choose File button and find the File you have just saved and select Open. Next, select the Import Option from the drop-down menu and choose the   EndNote Import filter. Thirdly, select To: and choose Unfiled folder. Finally, click on the Import button. A message confirms that the reference has been successfully added

11. Your Google Scholar references have now been exported into your EndNote basiclibrary.
 
	Tip: Always check each exported record to make sure that no information is incorrect or missing. 




4.4  IMPORT RECORDS FROM A DATABASE

In section 4.2, we learnt how to export references from databases into EndNote basic. However, many databases do not offer this export option. In such cases, you need to import the references into your EndNote basic library.

1. For this activity search the Science Direct database.

2. Select the records you wish to add to your EndNote basic library and click on Export.

3. Select the file format RIS (other file formats for other databases may also include ENW) and save the file to your computer (Downloads or Desktop).

4. Go to EndNote basic. Select the Collect tab, click on Import References.

5. Select the Browse button and find the File you have just saved and click on Open. Now click on the Import Option drop down menu and select the ScienceDirect filter. Click on the drop menu labelled To: and choose Unfiled folder. Finally, click on the Import button. 

6. Exported citations will be saved to the Unfiled folder and can be viewed from My References.

[image: Capture.JPG]

	Tip: Always check each exported record to make sure that no information is incorrect or missing. 




4.5  MANUAL ENTRY OF RECORDS

References can be manually entered into an EndNote basic library if the reference you want is not within any of the online search tools we have used so far (i.e. LibrarySearch, databases and Google Scholar).
To enter a reference manually:

1. Select the Collect tab, then click New Reference.
2. Select the appropriate Reference type.
3. Enter data into the desired fields, the fields commonly used by major style guides will appear first.
4. The reference is automatically saved.
5. The reference has now been manually inserted into your EndNote basic library.


	Tip: You can modify any reference within your EndNote library by selecting the title and editing content in any field.



4.6 CAPTURE REFERENCE

The Capture Reference feature can be utilised for online resources that do not have options for export/import for resources such as newspaper articles and blogs. Capture Reference scans the bibliographic information presented on a web page and creates a reference and saves to the Unfiled group. Please double check the fields to ensure accuracy and format are correct.

Note: To enable Capture Reference, go to the Downloads tab in your EndNote basic account and follow instructions. You may need to ensure that you show or enable the Bookmarks bar in your browser.

[image: https://lh5.googleusercontent.com/siS6m244T8K-ckTP5ZataeiHj8LizBuaUb7LtQqT7iYmWMDWGPhJGyOOrlptAk7winr1RdqRkPOgGPW6-xYzEKUgBg2v9JErkHjiWDQg3LKXLzVNSEm9-tx6g__4OoLJEiPVgXuW]


5.0 CREATE GROUPS AND SHARE REFERENCES

Create Groups

By default, EndNote places references into the Unfiled group. You can create up to 5000 groups to organise your references in any way that works for you.

Creating groups (folders) allows for the organisation of citations and is particularly useful for multiple projects or assignments. This helps keep your work organised and easy to use.

1. From My references select a few citations you want to group.
2. Click on add to group from the drop-down menu and select New group.
3. Name the new group and click OK.

[image: Capture.PNG]
Note: You can place a reference in multiple groups. To see which group(s) a given reference is currently in, click the Folder icon below the reference.

Sharing Groups

In Manage My Groups you can set up sharing of folders with anyone who has an EndNote basic account. This feature will be beneficial for those working on group assessments.


1. Select the Organize tab, and then Manage My Groups.

2. Click the Manage Sharing button next to the group you’d like to share and then select Start sharing this group.

[image: Capture.PNG]

0. Enter the email address your colleagues use to access EndNote basic, as they must have an EndNote basic account. Choose whether to give your colleagues read-only access or read & write access. Click Apply.

[image: Capture.PNG]

0. Read-only access allows designated users to view references, use them in Word documents, or copy them to their own library. 

1. Read & Write access allows the designated user to add, change, or remove references in the group, as well as anything Read-only access allows.

	Tip: The group automatically appears in your invitee’s online account, however, attachments/PDFs do not copy across.


6.0 ATTACHING FILES TO YOUR REFERENCES

Attachments can be added to references in your EndNote basic library. These attachment files can range from either PDF, Word doc, images etc.  

1. Select My References tab, then all references will display.
2. For each reference a paper clip image [image: Capture.JPG] will be evident, select the paper clip, then select Attach files.

[image: download.png]

3.  A maximum of 5 files can be added at one time to each reference. However, it is important to note the available space for file attachments are 2.0 GB in total for all references.

The Find it button will also provide the ability to search for the item through LibrarySearch.

	Tip: Any references with an attachment can be identified with a blue paper clip.




7.0 SELECTING REFERENCE STYLES IN ENDNOTE BASIC

It is important to select your referencing styles from your EndNote basic account prior to using EndNote with Microsoft Word. The selected referencing styles should be added to Favourites. Selecting a style and adding it to Favourites does not automatically display your references in that style. However, you can save or print a stand-alone bibliography of your references in that selected style -- see section 9.3.

1. Select the Format tab, and then Bibliography.

2. Choose Select Favourites, then search for, and add your desired referencing style/s by selecting Copy to Favourites.

3. Once referencing style/s are selected, click on Hide.

[image: Capture.GIF]



8.0 USING ENDNOTE BASIC WITH MICROSOFT WORD 

Cite While You Write (CWYW) allows you to use your EndNote basic references to insert citations in a Microsoft Word document. It automatically creates a bibliography from the inserted citations and allows you to change the format of your citations and bibliography.

To enable:

1. Open Microsoft Word.
2. Go to Preferences from the EndNote toolbar.
3. Then to Application.
4. Select EndNote online from the drop-down menu.
5. Enter your EndNote basic account details: email address and password.

[image: Capture.PNG]


8.1 Insert In-text citations into Word

1. From the EndNote toolbar in Microsoft Word click on the Insert Citations button.

2. Enter identifying text (e.g. author surname) and click the Find button and EndNote online will list matching results.

3. Select the reference(s) you wish to use and click the Insert button.

4. The reference(s) will be inserted into the text of the Word document, and a bibliography will be created at the end of the document.

5. Ensure you have selected the correct referencing style in Word
8.2  Edit in-text citations in Word

1. In Word, place the cursor on an in-text citation.

2. From the EndNote tab, click on Edit Citation(s) and select Edit Reference.

3. Endnote basic will open on the record, make any necessary changes.

4. You can also add page numbers to in-text citations when needed.

[image: https://lh4.googleusercontent.com/H_hSma2OH-4eeAONw0SB8FwEhJiBOVwsVkjudU_afuAoJICvUEed23wg34rIpsRW6QGIo8upt4Zl824Ax08XKi3wt1qlncRA3QEAy6Qj5ylOWqQJxaeQZI8U6QJQ1EMKBt-JKuTo]


9. FINAL TIPS 

The following are some further tips that will assist you with EndNote basic.

9.1 Online Search

Many library catalogues and databases can be searched through the EndNote interface. Click the Collect tab, then click Online Search, select an online database, perform your search, mark desired references, and use the drop-down menu to add them to your library.

[image: Capture.PNG]

9.2 Eliminate duplicate references 

It is possible to have duplicate records in a library. To identify and delete them, use the Find Duplicates link under the Organize tab. EndNote compares the Author, Year, Title, and Reference Type fields when identifying duplicates.

9.3 Bibliography

A stand-alone bibliography can be produced by going to Format > Bibliography, choosing your references and style, and exporting the bibliography through HTML or RTF (rich text file). 

9.4 EndNote Desktop 

Endnote Desktop is a bibliographic management software program for collecting, managing, storing and sharing references. It has full functionality and is the more sophisticated version of EndNote basic. EndNote Desktop is available on all RMIT student computers and can also be downloaded onto a personal device from the Library website. It can also be used in conjunction with EndNote basic and provides the ability to sync both libraries so that you will have identical groups and references in both versions. The sync process is always initiated from EndNote Desktop. Find more information from the Library’s Endnote: a Beginner’s Guide: http://rmit.libguides.com/endnote

10. CONCLUSION AND FURTHER HELP 
 
· RMIT Library cannot fix complex technical problems with specific EndNote libraries and documents. If you require advanced technical troubleshooting, please refer to EndNote.com
 
· Students and staff can ask for assistance related to EndNote basic in person at any Library service desk or via Ask a Librarian: https://www.rmit.edu.au/library/help/ask-the-library

· The Library’s EndNote Online guide is available if you require further assistance: http://rmit.libguides.com/EndNote_Online
Prepared by RMIT University Library
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